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Purpose

Purpose
The S-Style SmartMotor™ Installation and Startup Guide (the document you are currently reading)
provides an overview of the S-style SmartMotor, along with information on unpacking, installation and
start up. This guide is meant to be used in conjunction with the SmartMotor™ Developer's Guide, which
describes the SmartMotor features, SMI software, programming, commands, and other topics related
to SmartMotor application development.

NOTE: The features described in this guide apply to the S-style SmartMotor with firmware version
5.0.4.55 or later.

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics
website or contact your Moog Animatics representative.

Combitronic Technology
NOTE: This feature requires an S-style SmartMotor with the CANopen option.

The most unique feature of the SmartMotor is its ability to communicate with other SmartMotors and
share resources using Moog Animatics’ Combitronic™ technology. Combitronic is a protocol that
operates over a standard CAN interface. It may coexist with either the CANopen or DeviceNet
protocols. It requires no single dedicated controller1 to operate. Each SmartMotor connected to the
same network communicates on an equal footing, sharing all information, and therefore, sharing all
processing resources.

For additional details, see the SmartMotor™ Developer's Guide.

I/O Device CAN Bus Controller
NOTE: This feature requires an S-style SmartMotor with the CANopen option.

Expanded I/O capability allows the SmartMotor to interface with standard CiA 301 CANopen devices
and function as the I/O device CAN bus controller (i.e., no external bus controller is needed). For more
details, see the SmartMotor™ Developer's Guide. For CANopen object descriptions, see the
SmartMotor™ CANopen Guide.

1Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower",
respectively.
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Safety Information

CANopen

ABS Encoder

Be sure to comply with the guidelines for CAN bus cabling and termination.

CANopen Valve Block

CANopen

REMOTE I/O

Without data collision!
TM

Motor to MotorMotor to I/O®

SmartMotor as I/O Device CAN Bus Controller

Safety Information
This section describes the safety symbols and other safety information.

Safety Symbols
The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator
or major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to
comply with the instructions could result in slight injury to the operator or minor
damage to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations
The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to cover all
the safety standards and considerations that are part of the overall machine/system design and
manufacturing safety. Therefore, this information is intended to be used only as a general guideline for
the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 9.
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Motor Sizing

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized
for the specific application. Undersized motors may: perform poorly, cause excessive downtime or
cause unsafe operating conditions by not being able to handle the loads placed on them. The System
Best Practices document, which is available on the Moog Animatics website, contains information and
equations that can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system
designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment
for dust, high-humidity or presence of water (for example, a food-processing environment that requires
water or steam wash down of equipment), corrosives or chemicals that may come in contact with the
machine, etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme
conditions. For details, see the Moog Animatics Product Catalog.

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for
example, ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The
methodology and details of such an assessment are beyond the scope of this manual. However, there
are various sources of Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all
personnel who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:
l Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier
must be designed so that personnel cannot reach into any identified danger zones.

l Position the control panel so that it is outside the barrier area but located for an unrestricted
view of the moving mechanism. The control panel must include an E-stop mechanism. Buttons
that start the machine must be protected from accidental activation.

l Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

l Provide appropriate sensors and interlocks on gates or other points of entry into the protected
zone that will stop all machine movement when tripped.

l Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

l Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).
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Documentation and Training

l Prevent contact with a part that is thrown from the machine tooling or other part-handling
equipment.

l Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

l Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

l Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system
must be designed so that it does not automatically restart the machine/system after a power
failure.

l Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.

It is the responsibility of the operating company to ensure that:
l All operators, maintenance technicians, programmers and other personnel are tested and
qualified before acquiring access to the machine or system.

l The above personnel perform their assigned functions in a responsible and safe manner to
comply with the procedures in the supplied documentation and the company safety practices.

l The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

l Unauthorized access to the machine is prevented at all times.

l The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear, smocks or
aprons, gloves, hard hats and other protective gear.

l The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

l There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources
Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html
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Additional Documents

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm

Additional Documents
The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.

Related Guides
l Moog Animatics SmartMotor™ Installation and Startup Guides

http://www.animatics.com/install-guides

l Class 6 D-Style SmartMotor™ Installation and Startup Guide

http://www.animatics.com/cl-6-d-style-install-startup-guide

l SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

l SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

l SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
l SmartMotor™ Certifications

https://www.animatics.com/certifications.html
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Additional Resources

l SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status,
Serial Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

l Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources
The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:

l General company information:

http://www.animatics.com

l Product information:

http://www.animatics.com/products.html

l Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

l Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

l Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview
This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find
related documents and additional resources.

SmartMotor Introduction 14

SmartMotor Features and Options 14

S-Style Motors 15

Fieldbus Options 16

CANopen Fieldbus Protocol 16

Dual Power Configuration 17

IP65 Motors 18

SmartMotor Theory of Operation 19
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SmartMotor Introduction

SmartMotor Introduction
The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated
into a compact package. Its design is based on these objectives:

1. Reduce development time

2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 5 S-Style SmartMotor (34- and 23-frame)

The SmartMotor is powerful and unique because of its ability to control an entire machine. The
combination of programmability, networking, I/O and servo performance is unmatched. The SmartMotor
brings savings and value to the machine builder by removing complex and costly elements in the
machine design, such as PLCs, sensors, I/O blocks, cabinets, etc.

SmartMotor Features and Options
NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

All SmartMotors offer these features:
l Full floating-point math and trigonometric functions with 32-bit precision results

l Dual trajectory generators enabling relative and absolute position moves or velocity moves on
top of gearing or camming

l Advanced gearing allowing preset traverse and take-up winding parameters including dwells and
wrap counts
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S-Style Motors

l Advanced camming including cubic spline interpolation and dynamic frequency and amplitude
changes. Add onto gearing for complex traverse and take-up winding patterns.

l Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

l Virtual-axis control into camming through gearing, which enables stand-alone, multi-axis
coordinated motion

l Programmable and non-programmable protection features (both hardware and software)

A note about SmartMotor part numbers:

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the
Understanding SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

S-Style Motors
NOTE: In addition to this information, see Other S-Style Motor Changes on page 56 for limitations
of certain models.

S-style SmartMotors have:
l Depending on options selected, there can be a primary RS-232 communications port

l Depending on options selected, there can be a secondary RS-485 communications port

l Depending on options selected, there can be six channels of 5 VDC TTL non-isolated I/O

l Depending on options selected, there can be a dedicated, single-ended encoder output

These industrial (Fieldbus protocol) communications options are available on the S-style motors.
(Availability varies by model number; contact the factory for details.)

l CANopen option

For more details, see Fieldbus Options on page 16.

For the S-style motors, these features require an option that provides RS-485 communication:
l Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 1)

l DMX Follower (RS-485 COM 1)

In addition, a hardware DE power option is standard, which allows the controller and drive amplifier to
be powered from separate power sources. For more details, see Dual Power Configuration on page 17.

The S-Style motors are also IP65 sealed, except for the motor shaft, allowing them to be used in wet
environments if mounted shaft-down or to a sealed surface (like an IP-sealed gearbox). For more
details, see IP65 Motors on page 18.

The S-style motors are available in these NEMA frame sizes:
l NEMA 23

l NEMA 34

The next figure shows the connector locations for the S-style motors. For details on the S-style motor
connectors, see Motors: Connectors and Pinouts on page 1.
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Fieldbus Options

One of these:

•  Dedicated CAN Connector

•  5V TTL, IOs & CAN

•  5V TTL, IOs & Encoder Out

Power Connector

S-Style Motor Connectors

Fieldbus Options
This section details the Fieldbus communications protocol options that are available on certain models
of S-style SmartMotors.

CANopen Fieldbus Protocol

NOTE: This protocol is available on certain S-style SmartMotors.

The CANopen fieldbus protocol provides these features:
l Basic motion commands available through the CiA V4.02 specification

l Ability to read/write SmartMotor variables

l Use of onboard I/O through CANopen, SmartMotor programs or serial commands

l Ability to run 1000 SmartMotor subroutines through CANopen

l Online diagnostics of the SmartMotor through SMI software and serial connection

l Logical addressing for 127 nodes

l User program status/interrupts can be triggered by receive PDOs

l Baud rates of 20 Kbps, 50 Kbps, 125 Kbps (default), 250 Kbps, 500 Kbps and 1 Mbps
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Dual Power Configuration

NOTE: These 3 options apply 
to the connector below that is 
circled in red.

5-Pin, CANopen 
Connector

(female is standard)

CANopen Pins:

CAN-H

CAN-L

12-Pin, Com/4xIO/CAN 
Connector

(female is standard)

CANopen Pins:

CAN-L

CAN-H

5

6

4

5

CAN-L

CAN-H

7

8

Com/4xIO/CAN CAN Only

12-Pin, Com/6xIO/CAN 
Connector

(female is standard)

CANopen Pins:

CAN-L

CAN-H

7

8

Com/6xIO/CAN

Dual Power Configuration
The S-style SmartMotor's hardware dual power configuration allows the controller and drive amplifier
to be powered from separate DC power supplies (see the next figure).

This configuration provides these advantages:
l Controller can be powered from a standard 24-48 power supply

l Position will not be lost if drive power is lost

l No need to re-home

l Load surges will not cause a power surge on the controller

NOTE: All S-style SmartMotors are designed to allow the use of separate drive and control power
supplies. No special ordering option is needed for those SmartMotors.
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IP65 Motors

The next figure shows the connectors used for the power configuration.

CBLIP-S-PWR-FL

Separate  24V - 48V 
Control Power

24V - 48V Drive Power 

NOTE: The same power supply may be 
used for Control and Drive power, but 
maximum protection is provided with 
separate power supplies.

NOTE: These motors can operate on 
power down to +20 VDC, but it is not 
recommended due to greatly reduced 
performance — optimum perfor-
mance is achieved at 48 VDC.

S-Style SmartMotor Showing Dual Power Configuration

IP65 Motors
Certain models of SmartMotors, including the S-style, are available in IP-rated versions (see the Moog
Animatics Product Catalog for details). The standard IP rating is IP65, which protects the motor from
dust particles and splashing water. Contact Moog Animatics for details.

CAUTION: Although the S-style SmartMotor is IP65 rated, the motor's shaft is not
sealed.

To be fully sealed for use in horizontal or shaft-up vertical applications, it must be
mated, for example, to an IP-sealed gearhead with a sealed mounting surface or
using a sealant (Loctite 574 or similar) between the mating surfaces.

Alternatively, it can be mounted in a shaft-down vertical orientation where the
mounting surface itself may not necessarily be sealed.

IP ratings are in accordance with the code defined in international standard IEC 60529. Instead of the
vague descriptions of "waterproof", "water-resistant" or "dustproof", the IP-rating system provides a
uniform, quantifiable set of standards to which each product is rigorously tested. The IP code refers to
the degree of protection for the electrical enclosures on a machine against liquid, solid objects and
particulates. The first number after "IP" refers to the level of protection of the hazardous parts and
electrical enclosures against solid objects and particulates, and the second digit indicates the level of
water resistance. The higher the first digit rating in the IP system, the smaller the foreign object that it
is protected against.

SmartMotors with the IP65 rating are both completely dust tight and protected from ingress of liquid
that may occur from any angle (see CAUTION statement above), rendering no harmful effects on the
electrical enclosure. The IP-rated models provide the perfect integrated servo for food and beverage
manufacturing and packaging, rugged outdoor conditions, as well as any wet environment.
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SmartMotor Theory of Operation

Note that there are special IP-rated cables, which are available from Moog Animatics, that are designed
for use with the IP-rated SmartMotors. The next figure shows the cables, part numbers and
corresponding connections.

S-Style Motor PC/RS-232

CBLIP-S-PWR-FL

Separate 24V Control Power

24V - 48V Drive Power 

1
2
3
4

RS232485T

CBLIP-IO-FL

CBLIP-CAN-FL-xM

For all other 12-pin Comm/IO options:

For 5-pin CAN only (-C) option:

IP-Rated Cables and Connections

SmartMotor Theory of Operation
The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It
includes a controller, an amplifier and an encoder. All that is required for it to operate is power and
either an internal program or serial commands from outside (or both). To make the SmartMotor move,
the program or serial host must set a mode of operation, state a target position with/or a maximum
velocity at which to travel to that target, and a maximum acceleration. After these three parameters
are set, a "Go" command starts the motion profile.

The core functional areas of the SmartMotor are:
l Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

l System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

l Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

l I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.
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1.  MFMUL and MFDIV commands do not have an e�ect on  dwell time or distance.  Dwell is strictly based on  raw controller encoder counts selected by the 
SRC( ) command  specifying internal virtual or external controller count source.
2.  When feeding a Cam table with a gearing pro�le, changes to MFMUL and MFDIV will a�ect the time it takes to move through a Cam table but will not 
a�ect dwell time, as speci�ed in the previous note.

NOTES:

Current
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control

KII KPI
Torque
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MDE
MDT

Not supported on
S-style  motors

MFA
MFD
MFSLEW
MFSDC 1
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Move Pro�le

INTERMEDIATE
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3. External encoder is not available on the -C option models. See the Other S-Style Motor Changes topic  for more information. 

SmartMotor Theory of Operation Diagram
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Getting Started

Getting Started
This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment 23

Installing the SMI Software 23

Installation Procedure 23

Installation Verification 26

Accessing the SMI Software Interface 26

Understanding the Power Requirements 28

SmartMotor Power Requirements 28

S-style CPU, I/O and Communications Power 28

CPU Power Requirements 28

I/O Power Requirements 28

Communications Power Requirements 29

Understanding the Status LEDs 29

Connecting the System 29

Minimum Requirements 29

S-Style Motor Connectors and Pinouts 29

S-Style with Serial, 2xCAN and 4xI/O (SMxx165S, SMxx165S-BRK) 30

S-Style with Serial, 1xCAN and 6xI/O (SMxx165S-IO6, SMxx165S-BRK-IO6) 31

S-Style with CAN Bus (SMxx165S-C, SMxx165S-BRK-C) 32

S-Style with Serial, Encoder Out and 6xI/O (SMxx165S-EO, SMxx165S-BRK-EO) 33

S-style Cable Diagrams 33

Power Multidrop 34

RS-232 Multidrop with ENC and I/O 34

RS-232, 2xCAN and 4xI/O Multidrop 35

RS-232, 1xCAN and 6xI/O Multidrop 36

CAN Multidrop 37

CANopen Requirements 37

Detecting and Addressing the SmartMotors 37

Understanding the Detection and Addressing Options 37

Using the Find Motors Button 39

Using the Detect Motors Feature 42

Using the Address Motors Feature 44
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Getting Started

Checking and Clearing the Status Bits 46

Polling the Motor 47

Clearing the Fault Bits 48

Moving the SmartMotor 49

Making the Motor Move 49

Setting and Reporting Torque 50

Checking the Motor Position 51

Viewing the Motor Position with a Report Command 51

Viewing the Motor Position with the Motor View Tool 51
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment
Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and
packed at the factory.

When you receive your shipment, you should:
l Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

l Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be
corrected.

l Keep all boxes and packing materials. These may be needed for future storage or shipment of
the equipment.

Installing the SMI Software
The SmartMotor Interface software (SMI software) provides a convenient user interface for
programming the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft
Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure
NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove,
click Next and remove the existing software from your PC using the instructions.

After removing the existing software, restart the installation process.

NOTE: All personal settings and user files will be retained.
2. Click Next to proceed. The Installation Configuration page opens.
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-
screen instructions to complete the SMI software installation.
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Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in
the next figure. Click Finish to complete the installation and close the installation wizard.

NOTE: After the software is installed, be sure to restart your computer before running the SMI
software.

Installation Verification
To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

Accessing the SMI Software Interface
The SmartMotor Interface software (SMI software) communicates with a single or series of
SmartMotors from a Windows-based PC and gives you the capability to control and monitor the status
of the motors. The SMI software also allows you to write programs and download them into the
SmartMotor’s long-term memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not necessary to use the
SMI software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:

Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

Menu bar

Toolbar

Con!guration
window

Terminal
window

Information
window

Program
editor

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

These are the primary features in this interface:
l Menu Bar: All of the windows and functions of the SMI software can be accessed through the
menu bar. Many of these are also accessible through the icons on the toolbar.

l Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window,
some toolbar buttons may be disabled.

l Configuration Window (far-left window): This window is used to display the current
communication and detected motor configuration when no project is open, or the communication
and motor configuration defined in an open project.

l Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

l Information Window (lower window): This window is used to display the results of user
operations.

l Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other
Windows-based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

Understanding the Power Requirements
This section describes the power requirements for SmartMotor power, CPU power, I/O power and
Communications power.

SmartMotor Power Requirements
Requirement: The power range for S-style SmartMotors is from 24 VDC to 48 VDC; do not exceed 48
VDC. Main power must be connected to a source capable of supplying the rated power of the motor.

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to
greatly reduced performance -- optimum performance is achieved at 48 VDC.

Details: Some of the larger SmartMotors can draw high current. Therefore, heavy gauge wire is required
to connect the large motors. Control power consumes much less current. The exact amount depends on
I/O, communication and brake usage, but it is generally under 300 mA. For more information, see the
CPU, I/O and Communications Power section.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as a
power-off reset, under sudden load changes.

CAUTION: If power is reversed on any standard SmartMotor, immediate damage
WILL occur and the SmartMotor will no longer operate.

When relying on torque/speed curves, pay close attention to the voltage on which they are based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a
shunt resistor pack is not used. Protective shunts are available from Moog Animatics.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-
drive the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and
back-drive the power supply voltage above the safe limit for the SmartMotor. Many vertical
applications require a shunt to protect the SmartMotor from damage. Protective shunts are available
from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast
decelerations require shunts to protect the SmartMotor from damage. Note that
shunts should always be placed between the motor input and any disconnect or E-
stop relay to protect the motor when power is off or E-stop relay contacts are
open.

S-style CPU, I/O and Communications Power

CPU Power Requirements

Requirement: Maximum of 5 VDC on any I/O pin or 5 VDC pin.

Details: S-style SmartMotors have an internal 5 VDC power supply to run the internal CPU. This supply
can be easily damaged if an external voltage source of a higher voltage potential is applied. Therefore,
do not exceed 5 VDC on any TTL-level I/O pin or 5 VDC pin.

I/O Power Requirements

Requirement: Maximum sink amperage = 25 mA; Maximum source amperage = 25 mA.
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Communications Power Requirements

Details: Each on-board 5 V I/O pin has a minimum amount of protection consisting of a 100 ohm
current-limit resistor and a 5.6 VDC Zener diode. Each I/O pin also has a 5 kohm pull-up resistor. When
assigned as outputs, they act as a push-pull amplifier that drives hard to either the positive or negative
5 VDC rail. This means they are not open-collector I/O pins. Each I/O pin can sink up to 25 mA and
source up to 25 mA. Exceeding this could result in damage to the I/O port.

Communications Power Requirements

Requirement: Proper serial ground signal referencing and shielding techniques are required; do not use
the cable shield for the RS-232 ground reference.

Details: The S-style SmartMotor has a two-wire RS-232 port. This port meets IEEE standards with full
+/-12 VDC potential on the transmit line. Proper serial ground signal referencing and shielding
techniques must be used. Under no circumstances should the shield of a cable be used for the RS-232
ground reference. This could result in noise or corrupt data as well as ground loops that could damage
the serial port chip set.

Understanding the Status LEDs
The S-styleSmartMotor is not equipped with status LEDs. However, the status of the SmartMotor can
be easily obtained by one of these methods:

l Viewing the status bits using the Motor View tool in SMI, see the online help file in the
SMI software

l Reading the status bits, see the System Status chapter in the SmartMotor™ Developer's Guide

Connecting the System
This section describes system connections and cable diagrams for typical installations.

Minimum Requirements
At minimum, you will need:

1. An S-style 23- or 34-frame SmartMotor

2. A computer running Microsoft Windows and the SMI software

3. Power and data cables for the SmartMotor

4. Power supplies (for power requirements, see Understanding the Power Requirements on page
28)

S-Style Motor Connectors and Pinouts
The figures in this section provide an overview of the connectors and pinouts available on the S-style
SmartMotors. These figures apply to both the 23- and 34-frame motors.

CAUTION: The S-style motor's M12 (M-style) connectors must be finger tightened
only! DO NOT use a wrench or other tool. Doing so can cause overtightening of the
connection, which may damage the connector and will void the warranty.
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S-Style with Serial, 2xCAN and 4xI/O (SMxx165S, SMxx165S-BRK)

S-Style with Serial, 2xCAN and 4xI/O (SMxx165S, SMxx165S-BRK)

M12 12-PIN FEMALE

SERIAL, CAN AND I/O

M12 4-PIN MALE

POWER

DETAIL A
A

Pin Func on Specifica on

1 MAIN POWER +24-48VDC

2 CONTROL PWR +24-48VDC (DE Op on)

3 GND-MAIN Ground Main Power

4 GND-CNTRL Ground Control Power

Power

Pin Func on Specifica on

1 I/O - 0 25mA Sink or Source 10Bit 0-5VDC A/D

2 I/O - 1 25mA Sink or Source 10Bit 0-5VDC A/D

3 I/O - 2 25mA Sink or Source 10Bit 0-5VDC A/D

4 I/O - 3 25mA Sink or Source 10Bit 0-5VDC A/D

5 CAN_L non-isolated, 1MBaud Max

6 CAN_H non-isolated, 1MBaud Max

7 CAN_L non-isolated, 1MBaud Max

8 CAN_H non-isolated, 1MBaud Max

9 RS-232 Tx Com ch.0, 115.2 kBaud Max

10 RS-232 Rx Com ch.0, 115.2 kBaud Max

11 +5VDC OUT 50mA Max (total)

12 SIG GND Signal Ground

Communica on and I/O

PN Descrip on

Power CBLIP-S-PWR-FL S Power Cable, Flying Lead

CBLIP-S-PWR-EXT S Power Cable, M-F Extension

CBLIP-S-T-FFM S Power Cable, T Junc on

CAN, RS-232, I/O CBLIP-IO-FL Comms and I/O Flying Lead Cable; also RA op on

Relevant Cables NOTE: COM1 is not available on 

this model. See the Other S-Style 

Motor Changes topic  for more 

information.
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S-Style with Serial, 1xCAN and 6xI/O (SMxx165S-IO6, SMxx165S-BRK-IO6)

S-Style with Serial, 1xCAN and 6xI/O (SMxx165S-IO6, SMxx165S-BRK-IO6)

M12 12-PIN FEMALE

SERIAL, CAN AND I/O

M12 4-PIN MALE

POWER

DETAIL A
A

Pin Func�on Specifica�on

1 MAIN POWER +24-48VDC

2 CONTROL PWR +24-48VDC (DE Op�on)

3 GND-MAIN Ground Main Power

4 GND-CNTRL Ground Control Power

Power

Pin Func�on Specifica�on

1 I/O - 0 25mA Sink or Source 10Bit 0-5VDC A/D

2 I/O - 1 25mA Sink or Source 10Bit 0-5VDC A/D

3 I/O - 2 25mA Sink or Source 10Bit 0-5VDC A/D

4 I/O - 3 25mA Sink or Source 10Bit 0-5VDC A/D

5 I/O - 4 25mA Sink or Source 10Bit 0-5VDC A/D

6 I/O - 5 25mA Sink or Source 10Bit 0-5VDC A/D

7 CAN_L non-isolated, 1MBaud Max

8 CAN_H non-isolated, 1MBaud Max

9 RS-232 Tx Com ch.0, 115.2 kBaud Max

10 RS-232 Rx Com ch.0, 115.2 kBaud Max

11 +5VDC OUT 50mA Max (total)

12 SIG GND Signal Ground

Communica�on and I/O

NOTE: COM1 is not available on 

this model. See the Other S-Style 

Motor Changes topic  for more 

information.

PN Descrip�on

Power CBLIP-S-PWR-FL S Power Cable, Flying Lead

CBLIP-S-PWR-EXT S Power Cable, M-F Extension

CBLIP-S-T-FFM S Power Cable, T Junc�on

CAN, RS-232, I/O CBLIP-IO-FL Comms and I/O Flying Lead Cable; also RA op�on

Relevant Cables
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S-Style with CAN Bus (SMxx165S-C, SMxx165S-BRK-C)

S-Style with CAN Bus (SMxx165S-C, SMxx165S-BRK-C)

DETAIL A
A

M12 4-PIN MALE

POWER

M12 5-PIN FEMALE

CAN BUS

Pin Func�on Specifica�on

1 MAIN POWER +24-48VDC

2 CONTROL PWR +24-48VDC (DE Op�on)

3 GND-MAIN Ground Main Power

4 GND-CNTRL Ground Control Power

PowerPin Func�on Specifica�on

1 NC No Connec�on

2 NC No Connec�on

3 NC No Connec�on

4 CAN_H non-isolated, 1MBaud Max

5 CAN_L non-isolated, 1MBaud Max

Communica�on and I/O

PN Descrip�on

Power CBLIP-S-PWR-FL S Power Cable, Flying Lead

CBLIP-S-PWR-EXT S Power Cable, M-F Extension

CBLIP-S-T-FFM S Power Cable, T Junc�on

CAN CBLIP-CAN-EXT IP CAN Extension Cable

CBLIP-CAN-FL IP CAN Flying Lead Cable; also RA op�on

CBLIP-CAN-Y1 IP CAN Y Cable; also RA op�on

CBLIP-TRM120 Termina�ng Resistor, Male

CBLIP-TRF120 Termina�ng Resistor, Female

Relevant Cables NOTE: COM0 and COM1 are not 

available on this model. See the 

Other S-Style Motor Changes 

topic for more information.
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S-Style with Serial, Encoder Out and 6xI/O (SMxx165S-EO, SMxx165S-BRK-EO)

S-Style with Serial, Encoder Out and 6xI/O (SMxx165S-EO, SMxx165S-BRK-EO)

M12 12-PIN FEMALE

SERIAL, ENCODER OUT AND I/O

M12 4-PIN MALE

POWER

DETAIL A
A

Pin Func on Specifica on

1 MAIN POWER +24-48VDC

2 CONTROL PWRR +24-48VDC (DE Op on)

3 GND-MAIN Ground Main Power

4 GND-CNTRL Ground Control Power

Power

Pin Func on Specifica on

1 I/O - 0 25mA Sink or Source 10Bit 0-5VDC A/D

2 I/O - 1 25mA Sink or Source 10Bit 0-5VDC A/D

3 I/O - 2 25mA Sink or Source 10Bit 0-5VDC A/D

4 I/O - 3 25mA Sink or Source 10Bit 0-5VDC A/D

5 I/O - 4 or configurable as: RS-485 A Channel 1

6 I/O - 5 or configurable as: RS-485 B Channel 1

7 ENC A OUT Phase A Encoder Output

8 ENC B OUT Phase B Encoder Output

9 RS-232 Tx Com ch. 0, 115.2 kBaud Max

10 RS-232 Rx Com ch. 0, 115.2 kBaud Max

11 +5VDC OUT 50mA Max (total)

12 SIG GND Signal Ground

Communica on and I/O

NOTE: CAN bus is not available 

on this model. See the Other 

S-Style Motor Changes topic 

for more information.

PN Descrip on

Power CBLIP-S-PWR-FL S Power Cable, Flying Lead

CBLIP-S-PWR-EXT S Power Cable, M-F Extension

CBLIP-S-T-FFM S Power Cable, T Junc on

Encoder, RS-232, I/O CBLIP-IO-FL Comms and I/O Flying Lead Cable; also RA op on

Relevant Cables

S-style Cable Diagrams

CAUTION: The S-style motor's M12 (M-style) connectors must be finger tightened
only! DO NOT use a wrench or other tool. Doing so can cause overtightening of the
connection, which may damage the connector and will void the warranty.

NOTE: In these cable diagram figures, power and communications cables are shown with straight
connectors. Right-angle connectors are also available for most cables.
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Power Multidrop

Power Multidrop

Pwr Pwr Pwr

CBLIP-S-PWR-FL

CBLIP-S-PWR-EXT

Separate 24V

Control Power

24V - 48V

Drive Power

CBLIP-S-PWR-EXT

CBLIP-S-T-FFM

CBLIP-S-PWR-EXT

This power-connection method would be combined with a communications-connection method. For
example, see the diagrams in the next two sections.

RS-232 Multidrop with ENC and I/O

This communications-connection method requires S-style motors with RS-232, ENC and I/O option on
the 12-pin connector. This example shows I/O on motor 1 communicating with the Enc A/B signals on
motor 2.
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Enc A&B Pins 9-10
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Pin 11

+5 VDC Out

Pin 12

Signal GND
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RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

TxD

RxD

GND

P
in

 1
0

 R
x
D

P
in

 9
 T

x
D

P
in

 1
2

 G
N

D

P
in

 1
 I
/O

 0

P
in

 2
 I
/O

 1

P
in

 7
 E

n
c
 A

P
in

 8
 E

n
c
 B

P
in

 1
0

 R
x
D

P
in

 9
 T

x
D

P
in

 1
2

 G
N

D

P
in

 1
 I
/O

 0

P
in

 2
 I
/O

 1

P
in

 7
 E

n
c
 A

P
in

 8
 E

n
c
 B

This communications-connection method would be combined with a power-connection method. For
example, see Power Multidrop on page 34.
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RS-232, 2xCAN and 4xI/O Multidrop

RS-232, 2xCAN and 4xI/O Multidrop

This communications-connection method requires S-style motors with the RS-232, 2xCAN and 4xI/O
communication option on the 12-pin connector.

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-4

I/O 0-3

Pins 5-8

CAN L/H

Pairs
Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-4

I/O 0-3

Pins 5-8

CAN L/H

Pairs
Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-4

I/O 0-3

Pins 5-8

CAN L/H

Pairs
Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

NOTES: A terminating resistor (shunt) is required at each end of the bus.

              Bus must be multi-drop as shown, not a star network.

              24V CAN bus power connection is not required at the motor.
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NOTE: The CAN bus requires a termination resistor at each end. If the controller device (PC, PLC,
etc.) does not include one, then an external termination resistor must be supplied.

This communications-connection method would be combined with a power-connection method. For
example, see Power Multidrop on page 34.
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RS-232, 1xCAN and 6xI/O Multidrop

RS-232, 1xCAN and 6xI/O Multidrop

This communications-connection method requires S-style motors with the RS-232, 1xCAN and 6xI/O
communication option on the 12-pin connector.

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-6

I/O 0-5

Pins 7-8

CAN L/H

Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-6

I/O 0-5

Pins 7-8

CAN L/H

Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

CBLIP-IO-FL-xM

(12 Pin)

Pins 1-6

I/O 0-5

Pins 7-8

CAN L/H

Pins 9-10

RS-232 Tx/Rx

Pin 11

+5 VDC Out

Pin 12

Signal GND

NOTES: A terminating resistor (shunt) is required at each end of the bus.

              Bus must be multi-drop as shown, not a star network.

              24V CAN bus power connection is not required at the motor.
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NOTE: The CAN bus requires a termination resistor at each end. If the controller device (PC, PLC,
etc.) does not include one, then an external termination resistor must be supplied.

This communications-connection method would be combined with a power-connection method. For
example, see Power Multidrop on page 34.
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CAN Multidrop

CAN Multidrop
This communications-connection method requires S-style motors with the CAN only option on the 5-pin
connector.

CBLIP-CAN-Y1

CAN

CBLIP-

TRF120

CAN CAN

CBLIP-CAN-FL (5 Pin)PC, PLC,

etc.

(see NOTE)

NOTE: The bus requires a termination resistor at each end. If the controller device (PC, PLC, etc.)
does not include one, then an external termination resistor must be supplied.

This communications-connection method would be combined with a power-connection method. For
example, see Power Multidrop on page 34.

CANopen Requirements
The CANopen specification has requirements for network topology, bus length, drop lengths, etc. For
more details on this and the SmartMotor CANopen implementation, see the SmartMotor™ CANopen
Guide.

Detecting and Addressing the SmartMotors
This section describes how to detect and address the motors over the serial network. For details on
other communications methods, see Communication Details in the SmartMotor™ Developer's Guide.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
29.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 1.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

Understanding the Detection and Addressing Options
There are three different ways to use the SMI software to find and address the S-style SmartMotors
that are connected to your PC:
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Understanding the Detection and Addressing Options

l Use the Find Motors button—this method is recommended for first-time communications or
when you don't know the port used to connect the motors. For details, see Using the Find Motors
Button on page 39.

l Use the Detect Motors feature—this method can be used if you know the communications port
used to connect your motors and if your motors may be pre-addressed. For details, see Using the
Detect Motors Feature on page 42.

l Use the Address Motors feature—this method can be used if you know the communications port
used to connect your motors. This method always re-addresses the motors; therefore, if you
have pre-addressed motors connected, their addresses may be changed. For details, see Using
the Address Motors Feature on page 44.

These methods are described in the next sections.

Some notes about motor addressing:

The SmartMotors power up in non-echo state (so no response is sent to the next motor), 9600 KB
communications and a Base address of 0 (zero).

As the system addresses the motors in the RS-232 daisy chain, it starts with the first motor in the
daisy chain, sets its address to 1, enables echo, and then puts that motor to sleep. It proceeds to the
next motor in the daisy chain, sets its address to 2, enables echo and puts it to sleep. This process
continues until all the motors in the daisy chain are addressed.

When the motor is addressed, it contains a unique identifier that allows it to respond to commands
intended for that motor and ignore commands intended for other motors. For example, 1RPA reports
the position from motor 1 only; all other motors in the daisy chain ignore the command. However, a
global command, like 0RPA, reports the positions from all motors. For more details on addressing and
daisy chaining, see Daisy Chaining Multiple SmartMotors in the SmartMotor™ Developer's Guide.

Motor addresses are activated and stored using these methods:
l For serial addresses:

l These are stored in the SmartMotor's volatile memory, which means they are lost when
motor power is turned off.

l After setting the address, it goes into effect immediately (do not reboot or perform a
system reset with the Z command; either of these actions will delete the addresses).
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Using the Find Motors Button

l For CAN addresses:
l These are stored in the SmartMotor nonvolatile memory (NVRAM), which means they are
retained when motor power is turned off.

l After setting the address, it doesn't go into effect until the system is restarted or reset.

l The CAN address of a motor is different than the serial address (because they are
communicating on different networks). However, for ease of use, you can "store" the serial
address in the CAN address by entering the command:

CADDR=ADDR

Then, whenever you reset the system (either with the Z command or turning the power off
and back on), you can recall the serial addresses of the motors from the stored CAN
addresses, by entering the command:

0ADDR=CADDR     

Because the CAN address is permanently stored and doesn't change on power off or reset,
this allows you to easily restore specific serial addresses.

When addressing the motors, you can address serial and CAN in the same command, which means you
can use the serial network to communicate with the CAN bus. The leading number is the serial address;
the number after the colon character is the CAN address. Consider this example:

1RPA:2

The leading "1" is addressing the serial network motor 1; the ":2" is addressing the CAN network motor
2. In this example, the command is going out on the serial network to motor 1, then out the CAN port to
motor 2, reading motor 2 position info, and then echoing it back to the host from CAN to motor 1 and
then serial to host.

Using the Find Motors Button
The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next
figure). This method searches every communications port (serial, USB, Ethernet, etc.) on the PC. If you
don't know which port your motor is connected to, this method is the most thorough way to search.
However, if you have many ports, this method can also take a long time.

To begin searching for motors across all ports on the PC, in the Configuration window of the SMI
software interface, click Find Motors. The SMI software begins searching for all SmartMotors
connected to the PC.
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Using the Find Motors Button

Find Motors Detecting SmartMotors on the RS-232 Chain

After the motors are detected, the SMI software will address them if needed. The next steps are only
used when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see this prompt:

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information
is the same as that shown in the Motor View window, which can be accessed by selecting the Tools >
Motor View > Info tab:
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Using the Find Motors Button

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor
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Using the Detect Motors Feature

Using the Detect Motors Feature
This method is similar to the Find Motors method, but it searches only the specified communications
port for connected SmartMotors.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the
desired communications port and select Detect Motors from the menu.

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications
port. A progress bar is shown while the SMI software searches for the motors.

After the motors are detected, the SMI software will address them if needed. These steps are only
used when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see this prompt:

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information
is the same as that shown in the Motor View window, which can be accessed by selecting the Tools >
Motor View > Info tab:
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Using the Detect Motors Feature

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor
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Using the Address Motors Feature

Using the Address Motors Feature
This method assumes that there are motors connected to the specified port and will simply address
each one that it finds.

NOTE: This method will address (or re-address) every motor. If you pre-addressed your motors
before connecting them, those motor addresses could be changed by this process.

To use the Address Motors feature, in the Configuration window of the SMI software, right-click the
desired communications port and select Address RS-232 Chain from the menu.

Selecting the Address Motors Feature

To address the motors, click Yes when you see this prompt:

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting information on each motor. The information
is the same as that shown in the Motor View window, which can be accessed by selecting the Tools >
Motor View > Info tab:
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Using the Address Motors Feature

Motor View Information

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Addressed SmartMotor
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Checking and Clearing the Status Bits

Checking and Clearing the Status Bits
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
29.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 1.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

l The SmartMotor has been detected and addressed.
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Polling the Motor

Polling the Motor
To view the current state of the status bits, you must poll the motor.

1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

Motor View

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see
the red status bits numbered 10 through 15 in the previous figure).
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Clearing the Fault Bits

Clearing the Fault Bits
To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next
figures.

ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive
is operating properly.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
29.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 1.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

l The SmartMotor has been detected and addressed.

l The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page
46.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be
considered in the workcell design (see Other Safety Considerations on page 8).

To make the SmartMotor move:

1. In the Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Tab Selected that Matches the Communications Channel

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 57 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands.
For details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor
to a stop.

Setting and Reporting Torque
The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-
width modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example,
T=3000, but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than
the T (torque) value due to internal calculations. It may also be reduced in cases where the motor’s
output is in limitation. TRQ represents the output effort of the motor in both MT (torque mode) and
servo modes (MV, MP, etc.). Therefore, it provides a seamless transfer across those modes without
causing a ripple or bump in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is; you can view the current sample
rate with the RSAMP command.
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Checking the Motor Position

Checking the Motor Position
There are several ways to check the motor position:

l Report the position using commands from the Terminal window

l View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's
Guide.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
29.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 1.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

l The SmartMotor has been detected and addressed.

l The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page
46.

Viewing the Motor Position with a Report Command
To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:

RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, it
is just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.

Viewing the Motor Position with the Motor View Tool
The Motor View tool provides another way to view the motor position. The advantage of using this tool
is that the position is dynamically updated when the motor is moving.

Moog Animatics Class 5 S-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 51 of 60

http://www.animatics.com/smartmotor-developers-guide
http://www.animatics.com/smartmotor-developers-guide


Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you
want to view and select Motor View from the menu.

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from)
the motor. After polling begins, the motor position is shown in the Position box.

Motor View Tool Showing the Motor Position
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Connectors, Pinouts and Examples

Connectors, Pinouts and Examples
This chapter provides information on the SmartMotor connector pinouts and specifications. It also
provides example I/O connection diagrams. For information on connecting the motors, see .

Class 5 S-Style Connector Pinouts 54

Class 5 S-Style I/O Connection Examples 55
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Class 5 S-Style Connector Pinouts

Class 5 S-Style Connector Pinouts
This table shows the pinouts for the connectors on the Class 5 S-style SmartMotors.

PIN MAIN POWER P1
1 Main Power  
2 Control Power
3 Common Ground Ground
4 NC

PIN I/O CONNECTOR (5V TTL I/O) P2 Enc Out or CAN Option
1 I/O – 0 GP or Encoder A or Step Input 25 mAmp Sink or Source 

10 Bit  0-5 VDC A/D
1.5 MHz Max as Encoder 
or Step Input

2 I/O – 1 GP or Encoder B or Direction Input 25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

1.5 MHz Max as Encoder 
or Direction Input

3 I/O – 2 Positive Over Travel or GP 25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

4 I/O – 3 Negative Over Travel or GP 25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

5 I/O – 4 GP, IIC (SDA) or RS-485 A (Ch. 1)
or CAN-L based on motor option

25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

115.2 KBaud Max

6 I/O – 5 GP, IIC (SCL) or RS-485 B (Ch.1)
or CAN-H based on motor option

25 mAmp Sink or Source
10 Bit  0-5 VDC A/D

115.2 KBaud Max

7

8

9

Phase B Encoder Output

10
RS-232 Transmit Com ch. 0 115.2 KBaud Max

11
RS-232 Receive Com ch. 0 115.2 KBaud Max

12
+5 VDC Out 50 mAmp Max (total)
Common Ground

PIN CAN bus Connection: P2 CAN Only Option

1 NC NC

2

3

4 CAN-H 1 MBaud Max

5 CAN-L 1 MBaud Max

M12 5-Pin Female

Notes:

Notes:

Notes:

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

NOTE: I/O ports input impedance = 5 kohm (5 kohm pull-up resistor)

CAUTION: Connectors P1 and P2 must be finger 
tightened only! DO NOT use a tool. Doing so can cause 
overtightening of the connection, which may damage 
the connector and will void the warranty. 

+24-48VDC
+24-48VDC (DE Option)

Phase A Encoder Output

Encoder B OUT or 
CAN-H based on motor option

Encoder A OUT or 
CAN-L based on motor option

M12 12-Pin Female

M12 4-Pin Male

Typ. SIG Ground

Non-isolated

Non-isolated

NC NC

NC NC

1 MBaud Max, Non-isolated

P1P2

1 MBaud Max, Non-isolated

1 MBaud Max, Non-isolated

1 MBaud Max, Non-isolated

Specifications:

Specifications:
See NOTE
See NOTE

NOTE: These motors can operate on power down to +20 VDC, but it is not recommended due to greatly reduced performance — 
optimum performance is achieved at 48 VDC.
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Class 5 S-Style I/O Connection Examples

Class 5 S-Style I/O Connection Examples
The next figure shows I/O connection examples for the Class 5 S-style motors that have the 12-pin
communication and I/O connector. Also, refer to Connector Pinouts on page 1 for connector
specifications.

1

2

3

4

5

6

7

8

9

11

12

10

Port 0 (Enc A or Step Input)

Port 1 (Enc B or Dir Input)

Port 2 (Pos or Right Limit)

Port 3 (Neg or Left Limit)

CAN_H (non-isolated, 1MBaud Max)

CAN_L (non-isolated, 1MBaud Max)

CAN_H (non-isolated, 1MBaud Max)

RS-232 Tx

RS-232 Rx

+5 VDC Out

Signal GND

Gnd 5VGnd
B A

CAN_L (non-isolated, 1MBaud Max)

Optical
Encoder

M12 12-Pin Female

CANopen to
next node

CANopen 
terminator if 

first/last 
node on bus

Quadrature Signals

Pos / Right Limit (Dry Switch)

Neg / Left Limit (Dry Switch)

SMARTMOTOR (SM23165S, SM23165S-BRK) 
12-PIN M12 I/Os
NOTE: I/O is Sinking type (NPN)

Digital I/O

Analog Input

Counter or Comm +5V

5k

Input 0

5.6V

100

CPU

Knowing the SmartMotor's internal schem-
atic can be useful when designing external
interfaces. SmartMotor I/O is logic 0 for
voltages below 1.2V and logic 1 for
voltages above 3.0V. Note that logic states
for voltages between these are unpre-
dictable.

NOTE: For improved linearity of analog potentiometers, select one that is less than or equal to the
motor's internal pull-up resistor. For example, if the motor's pull-up resistor is 5 kohm, use a
potentiometer that is no greater than 5 kohm.

Moog Animatics Class 5 S-Style SmartMotor™ Installation and Startup Guide, Rev. D

Page 55 of 60



Other S-Style Motor Changes

Other S-Style Motor Changes
In addition, please note these items:

Features Not Available
These Class 5 SmartMotor features have not been implemented in the S-style SmartMotors:

l Some fieldbus communications (DeviceNet, PROFIBUS, etc.) are not available. However, CAN bus
is available on several models. It is not available on the -EO option models.

l COM 0 port is not available on the -C option models. Therefore, those models do not support
field upgrade of the motor firmware. Contact Moog Animatics applications engineering for more
details.

l COM 1 port (second serial port) is not available on the base or -C option models; it is only
available on the -EO option models.

l The -C option models do not support an external encoder.
l The SMI software CAN Lockup Wizard requires firmware version 5.0.4.55 or later; older versions
will not support it.

Commands Not Currently Supported
These commands are not currently supported in the S-style SmartMotor:

Not applicable — all Class 5 commands are supported.

For Further Information...
For further information on SMI software features, SmartMotor programming details, communication
details, motion details, a complete command reference and more, see the SmartMotor™ Developer's
Guide.
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Troubleshooting
This section provides troubleshooting information for common problems. For additional support
resources, see: http://www.animatics.com/support.html.

Issue Cause Solution
Communication and Control Issues
Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all
connected properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use
the Communications Lockup Wizard located on the SMI
software Communications menu.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest
values. This is done In the Windows Device Manager>
Advanced Settings dialog box for the associated COM
port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes
it to brown-out during motion. Make moves less
aggressive, increase PSU size or change to a linear
unregulated power supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.
NOTE: Serial addresses are lost
when motor power is off or
reset.

Use the SADDR or ADDR= command within the program
to set the motor address.

Motor doesn't turn. Faults not cleared. Clear faults (see Checking and Clearing the Status Bits on
page 46).).

Common Faults
Bus voltage fault. Bus voltage is too high for

operation.
Check servo bus voltage. Check for excessive
regenerative energy from motor due to no/insufficient
shunt resistor.

Bus voltage is too low for
operation.

If motor uses the dual-power configuration (separate
drive and control power supplies), ensure that both power
supplies are connected and are sized correctly for the
motor.

Overcurrent occurred. Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault. Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced
air cooling to the system.

Excessive position error. The motor's commanded position
and actual position differ by
more than the user-supplied
error limit.

Increase error limit, decrease load or make movement
less aggressive. Also, ensure you are not voltage limited
for the torque at speed required. If running from less
than 48 VDC, check ratings for lower bus voltages and
ensure the motor is within required torque capacity.

Motor faults on position error
only after a certain amount of
time.

Motor sized incorrectly. Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage
limited for the torque at speed required. If running from
less than 48 VDC, check ratings for lower bus voltages
and ensure the motor is within required torque capacity.Motor is not accurately

corresponding to trajectory.
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Issue Cause Solution
Programming and SMI Issues
Several commands not
recognized during compiling.

Compiler default firmware
version set incorrectly.

Use the Compiler default firmware version option in the
SMI software Compile menu to select a default firmware
version closest to the motor's firmware version. In the
SMI software, view the motor's firmware version by
right-clicking the motor and selecting Motor Properties.
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